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Add a Movie
PowerPoint 2003

Go to the Insert menu, choose Movies and Sounds, and select Movie From File.

You will see the Insert Movie dialog.
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Use the Look in pull-down menu to find the movie you want to use.

Click the movie file to select it.
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Insert Movie E
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Click the OK button.

You will see a Microsoft Office PowerPoint dialog.

Microsoft Office PowerPoint

- | ) How do wou want the movie to skart in the slide show?

| Aukomatically | | When Clicked

Click the Automatically button to have the movie play right away when the slide shows.
Click the When Clicked button if you want to click the movie to have it play.

You will see the first frame of the movie in the middle of the slide.
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To move the movie, click and drag it to a new place on the slide.

To resize the movie, click and drag one of the handles. Drag toward the center of the
movie to make it smaller and drag away from the movie to make it larger.

To watch the movie while you are working, double-click it.

To test the movie, click the Slide Show from current slide button.

sa%
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Add a Sound
PowerPoint 2003

Go to the Insert menu, choose Movies and Sounds, and select Sound From File.

You will see the Insert Sound dialog.

Insert Sound
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Click the Look in pull-down menu to find the sound you want to add.

Click the sound file to select it.
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Insert Sound
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Click the OK button.

You will see a Microsoft Office PowerPoint dialog.

Microsoft Office PowerPoint

1 ) How do wou want the sound to start in the slide showy

| Automatically | | when Clicked

Click the Automatically button to have the sound play right away when the slide shows.

Click the When Clicked button if you want to click the icon to hear the sound.

You will see a sound icon in the middle of the slide.
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Click and drag the icon to a new place on the slide.
Double-click the icon to hear the sound.

Go to the Slide Show menu and choose View Show.
Click through the presentation to the slide with the sound.
You will hear the sound play in your presentation.

You may have to click the sound to hear it.

Add a Custom Animation
PowerPoint 2003

Navigate to a slide with multiple objects on it, such as a text box and a graphic.
Go to the Slide Show menu and choose Custom Animation.

You will see the Custom Animation task pane on the right.
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Custom Animation v o
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In the Slide pane, click an object on the slide.

Recipes4Success www.tech4learning.com ©2005 Tech4Learning, Inc.



PPT Intermediate for PC

Page 10 of 30

Animals

# There are mary
neat animalz in
the rainforest
Canopyy . o anll
zee patots and
other kirds.

# [f woul stay out
late, wou might

ZER OF hest &
sloth.

The Add Effect button on the Custom Animation task pane will become active.

‘ﬁ Add Effect -

Click the Add Effect button, choose the type of Effect you want to use, and select an

option from the list.
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Custom Animation b 4
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Click the Play button to see a preview of the animation in the Slide pane.

.F F'Ia*;.f.

You can modify the animation using the pull-down menus in the Modify area.

Modify: Checkerboard

Start; “3 on Click
Cirection: Acrnss
Speed: Yery Fast
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To have the animation play automatically, click the Start pull-down and choose After
Previous.

Modify: Checkerboard

St 3 on Click v
Direction:  [*3 ©n Click

speed! With Previous

@ After Previous

You can change the timing of the animation.

Click the animation object pull-down menu in the task pane and choose Timing.
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Custom Animation v o
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At the dialog that appears, use the Delay arrows to set the timing for the animation.
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Checkerboard
Effect | Timing |
Start: “B on Click v
Delay: . seconds
Speed; 2 seconds (Mediurn) W
Repeat: | {none)

[ | rewind when done playing

Ik | | Zancel

Click the OK button.
Click another object on the slide.
Click the Add Effect button and choose an animation effect for this object.

You will see the order of the animations on this slide in the task pane.
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Use the Re-Order buttons to change the animation order of the objects.

E] Re-Order -

Click the Play button to preview what the animations will look like on the slide.

| > Flay _
The animation will be applied to the current slide.

Add an Action Button
PowerPoint 2003

Go to the Slide Show menu, choose Action Buttons, and select a button from the
options.

Move the cursor over the slide. The cursor will be a crosshair.

_|_

Click and drag to draw the button on the slide.
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&

Release the mouse button.
You will see the Action Settings dialog.
Click the radio button for the action you want for the button.

Use the pull-down menus to make your specific selections.
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Action Settings

Mouse Click, | Mouse Crver |

action on click,

First Slide W

'l:i' Eun program:

Browse, ..

Fun macro:

iObject action:

[ ]Play sound:

Highlight click:

2K | | Cancel

Click the OK button.

S 4
. A
|

Recipes4Success www.tech4learning.com ©2005 Tech4Learning, Inc.



PPT Intermediate for PC Page 18 of 30

You will see the button on the slide.

Animate Objects
PowerPoint 2003

Go to the Slide Show menu and choose Animation Schemes.

You will see the Slide Design task pane on the right.

Slide Design v

Cle | a

=l| Design Templates
_a=i Color Schemes
¢y Animation Schemes

Apply to selected slides:

Mo Animation h
Mo Aanimakion

Subtle

Appear

Appear and dim o

| apply to All Slides |

- |E Slide Show |

BuboPreview

In the Apply to selected slides field, choose the animation you want to use as the object
enters.
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Apply to selected slides:

Fade in one by one *"'"*

Fade in and dim

Faded zoom [E

Brush on undetline o

The animation scheme will be applied to the objects the current slide.

Click the Apply to All Slides button to add this animation scheme to every slide in the
presentation.

_ Apply to Al Slides _

Automatically Advance a Slide
PowerPoint 2003

Go to the Slide Show menu and choose Slide Transition.

You will see the Slide Transition pane on the right.
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: slide Transition v ow

Apply to selected slides:

Checkerboard Across
Checkerboard Down -

Modify transition

Speed:

Fast "
Sound:

[MNo Sound] "

Advance slide

ion mouse click
[ ] Automatically after

e
w

| apply to All Slides |

|F Play | |E Slide: Shiow |

AukoPreview

Choose a transition, speed, and sound.

In the Advance Slide area, click the Automatically after check box.
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Advance slide
ion mouse click

Use the arrows to choose the timing.

Advance slide

on mouse click,
Automatically after

TS

This automatic advance will be added to the current slide.

Click the Apply to All Slides button to add this auto advance to every slide.

_ Apply to Al Slides _

Make a Roll Over Action
PowerPoint 2003

Navigate to a slide that contains an object with an action.

Click the object to select it.

Go to the Slide Show menu and choose Action Settings.

The Actions Settings dialog is currently set to Mouse Click.
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Action Settings b—q

Mouse Click | Mause Cwer

action on click,

hitkp: [ finsectzoo, msstate, edu)students) w

'l:i' Eun program:

Browse, ..

Fun macro:

iObject action:

[ ]Play sound:

[ Highlight click

2K | | Cancel

Click the Mouse Over tab.

Maouse Click, | Maouse Over

Adjust the settings on this tab to determine the actions when the cursor rolls over the
object
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Action Settings ['5_(|

Mouse Clickl Mouse Crver |

Ackion on modse aver
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'l:i' Eun program:

[ ]Play sound:

[ ] Highlight when mouse over

2K | | Cancel

Click the OK button.
To test the mouse over, go to the Slide Show menu and choose View Show.

When the slide with the mouse over action appears, instead of clicking the object,
move the cursor over the top of it to activate the action.

Play Music from an Audio CD
PowerPoint 2003
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Place an audio CD in the CD-ROM drive of the computer.
Go to the Insert menu, choose Movies and Sounds, and select Play CD Audio Track.

You will see the Insert CD Audio dialog.

Insert CD Audio

Clip selection
Skark ak track: |1 | Eime: |00:00 % | seconds
End ak krack: |22 & | bime: [01:55.33 % | seconds
Play options
[ ]Loop until stopped
Sound vaolume:
Display opkions
[ ]Hide sound icon during slide show
InFormnation
Tokal playing bime:  1:07:36.35
File: [CD Audio]
Ok Cancel

Use the arrows in the Start at track field to choose the track where you want to begin
playing audio.

Use the arrows in the End at track field to choose the track where you want to stop
playing audio.

Use the time fields to choose the exact spot in the music you want to start and stop.

Recipes4Success www.tech4learning.com ©2005 Tech4Learning, Inc.



PPT Intermediate for PC Page 25 of 30

Insert CD Audio

Clip selection
Stark ak track: |3 | Eme: |00:00 % | seconds
End ak krack: |3 = | Eime: | EEE] % | seconds
Play options
[ ] Loop until stopped
Sound volume:
Display options
[ |Hide sound icon during slide show
InFormation
Toktal playing time:  00:44
File: [CD Audio]
| Ok | | Cancel

Click the OK button.

You will see a Microsoft Office PowerPoint dialog.

Microsoft Office PowerPoint

1 ) How dio wou want the sound ko skart in the slide show?

| fukarnatically | | When Clicked

Click the Automatically button to have the sound play right away when the slide shows.

Click the When Clicked button if you want to click the icon to hear the sound.
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You will see a sound icon in the middle of the slide..

You will see a CD icon in the middle of the slide.

O g
o J'C'
LE I

To move the icon, click and drag it to a new place on the slide.
To listen the sound while you are working, double-click the CD icon.

To test the sound, click the Slide Show from current slide button.

=]

The CD must be in the CD drive when you view the presentation.

Record Narration
PowerPoint 2003

To record narration, you must have a microphone attached to the computer. The sound
input at the computer s control panel must be set to microphone. You may also need to
adjust the record volume.

Move to the first slide of your presentation.

Go to the Slide Show menu and choose Record Narration.

You will see the Record Narration dialog.

Adjust the recording settings before you begin.
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Record Narration §|
iCurrent recording quality ok
Quality: [untitled]
Disk use:; 10 kbjsecond Cancel

Free disk space: 12961 ME {on C:4)

Max record bime: 20546 minukes Set Microphane Lewel. .

Change Quality, ..

Tip

recording quality uses more disk space, Large narrations should be linked For better

s Adjust quality settings ko achieve desired sound quality and disk usage. Higher
@ petformance,

[ ]Link narrations in: ... \Student Presentations! Browse. ..

When the settings are adjusted correctly, click the OK button.
PowerPoint will run the presentation.

Record the narration for the first slide. When you are finished, click the mouse button to
advance to the next slide.

Record narration for this slide and click the mouse button to advance to the next slide.

Repeat this process until you have recorded all the narration you want to add to the
presentation.

When you are finished, you will see a Microsoft PowerPoint dialog asking if you want to
save slide timings as well.

Microsoft Office PowerPoint

1 ) The natrations have been saved with each slide. Do wou want to save the slide timings as well?

Save ] [ Don't Save
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Click the Save button to set an automatic advance on each slide according to the
speed you navigated through the project when recording narration.

Click the Don t Save button to keep the original slide advance settings.

To test the narration, go to the Slide Show menu and choose View Show.

Print Handouts
PowerPoint 2003

Go to the File menu and choose Print.
You will see the Print dialog.

Click the Print what pull-down menu and choose Handouts.
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Printer
Mame: ¥ HP Laserlek 4000 Series
Skatus: Idle
Tvpe: HP LaserJet 4000 Series PCL &
Where: HPLaserJet40005eties
Comment:
Print range
() all () Current slide
() slides:
Enter slide numbers andfor slide ranges, For example,
1,3,5-12
Print what: Handouks
Handouts 55 Slides per page: |6 W
Slides Order: (%) Horizontal
Mokes Pages
Quitlin Yiew [ ] Scale ta fit paper
Frame slides

W

_opies

() vertical

| Properties |

| Find Printer. .. |

[ Print to File

Murnber of copies:
1 ¥

EE
BE
HE

Ik

| | Cancel

Click the Slides per page pull-down and choose how many slides to print on each page.
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Printer
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Where: HPLaserJet40005eties
Cormment: [_IPrint ta file
Print range _opies
OF ) Current slide Murnber of copies:
1 e
w
() slides: yﬂ y—ﬁ
Enter slide numbers andfor slide ranges, For example, 1 = 1 :
1,3,5-12
Collate
Print what: Handouks
Handouts s Slides per page: |3 v L] E
Colorfgrayscale: 1 —
al —
Zolor L z -
[ ] Scale ta fit pape]f-} k
Frame slides g
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Click the OK button.
The slides will print as thumbnails on each page.

If you choose 3 slides per page, there will be lines by each slide for notes.
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